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1 Introduction

Scope

The scope of this document describes how to use and modify the DELMIA 3DPlay Experience
for Work Instructions option in Apriso. This includes the ability to view a list of Orders, select
and open an Order, interact with a 3D viewer, navigate to the Order's Operations and Steps,
and view lists of Parts and Tools required for the execution of the Order.

Intended Audience

The intended audience for this document is process authors configuring Work Instructions to
be displayed using Screen Flows.

Glossary

Order - An Apriso object used to describe work to be performed.

Work Instructions 3D Business Control — A Business Control that displays the Parts and
Tools for Operations and Steps in a 3D viewer.
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2 Overview

The DELMIA 3DPlay Experience for Work Instructions is delivered in a set of GPM packages
that can be deployed in DELMIA Apriso system.

The packages contain the 3DPlay control used for viewing 3D work instructions authored in
DELMIA as well as Screens and Views for selecting Orders, Operations, Parts, and Tools.
The selection of the Order components moves the user to different points in the 3D work
instructions and highlights the Parts and Tools selected.

The Experience package can be used as-is to view 3D work instructions associated with an
Order. The package can also be a starting point for a customer implementation of 3D work
instructions by services and can be modified to fit customer data and processes.
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3 Installation
3.0.1 3DEXPERIENCE Platform and DELMIA Apriso Compatibility
Matrix

The table below shows which versions of the 3BDEXPERIENCE Platform are compatible with
DELMIA Apriso releases.

3DEXPERIENCE Platform DELMIA Apriso

R2018x FD0O1-FD05 DELMIA Apriso 2018 SP2 through 2019 SP1
R2019x GA

R2018x FDO6+ DELMIA Apriso 2019 SP2 and newer
R2019x FDO1+

3.1 Prerequisites

» Incoming Messages Monitor configuration

3DPlay Experience for Work Instructions uses DELMIA Apriso Process Plan Resource
integration and requires a correct Incoming Messages Monitor configuration. For more
information refer to the Incoming DELMIA Messages Configuration — DELMIA Apriso
Configuration Manager section of the DELMIA Plan Approval and Distribution Integration
Implementation Guide.

> 3DPlay in DELMIA Apriso Mobile Application

3DPlay control is supported on tablet devices running the following mobile operating
systems:

> i0S 13 or higher
> Android 7.0 or higher

O Not every 3D model will load on every device. The available memory on a device
determines its loading capacity.

3.2 Prerequisites for Connected Mode

Connected mode in DELMIA Aprisomeans the ability to view in 3DWork Instruction Views and
Product Build that are stored in the 3SDEXPERIENCE Platform directly in DELMIA Apriso.

If no 3DXML is found in DELMIA Apriso for the given WIP Order, then the 3D model will be
loaded directly from the 3DEXPERIENCE Platform.

The following additional requirements must be met for the Connected Mode:
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» 3DPassport and SSL must be configured on DELMIA Apriso server
O ror configuration details, see Security Implementation Guide.

» The 3DSpace service URL previously configured on the 3DEXPERIENCE Platform must
be specified in the webserviceProviders.xml file in Central Configuration directory on DELMIA
Apriso server

O rFor 3DSpace installation instructions, refer to 3SDEXPERIENCE Platform User
Assistance on 3DS Support.

» 3D Work Instructions data must be generated and exported to DELMIA Apriso using the
Connected Mode setting in Work Plan Publication application on
3DEXPERIENCE Platform

» The user must have the IFW, CSV, and WKB licenses on 3SDEXPERIENCE Platform

3.3 Install and Configure DELMIA 3DPlay Experience for
Work Instructions Page

All the resources required to install and configure 3DPlay Experience for Work Instructions in
DELMIA Apriso are available from the dedicated Install and Configure DELMIA 3DPlay
Experience for Work Instructions page.

‘% DELMIA Apriso 2021 | Install DELMIA 3DPlay Experience for Work Instructions

The DELMIA 3DPlay Experience for Work Instructions supports the display of 3D data with work
instructions on the manufacturing shop floor. It includes the Work Instructions 3D Business
Control and the Work Instructions 3D FlexPart.

Documentation

3D Work Instructions Implementation Guide
Provides an overview of 3D Work Instructions and describes how to use the Wi Experience 3DPlay
Business Control.

#| Database Documentation
Enables viewing DELMIA Apriso database (DB) tables (organized into groups), their descriptions, and
the relations between them.

| Process Builder Help
Provides an overview of DELMIA Apriso Process Builder (PB) and information on installing and using

the application. This Help describes the user interface elements, entity maintenance, available
Business Controls, and management of Processes, Operations, and Screen Flows.

Components (GPM Packages)

The GPM Package files need to be deployed on DELMIA Apriso server for dedicated Database
Management System (SQL/Oracle) and in a specified sequence both indicated below (and in their file
names).

@] 3DPlay Work Instructions 20 Cockpit

Figure 1 DELMIA 3DPlay Experience for Work Instructions Page

To access the page:
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1. Load http://<server name>/Apriso/Start. The DELMIA Apriso Start page is displayed.
2. Switch to the Server Configuration page using the wrench icon in the top right-hand corner.

,EJ?S DELMIA Apriso 2021 | Start

Welcome to DELMIRA Rpriso

Log In to DELMIA Apriso Portal

Log in to the new DELMIA Apriso Portal to search and access FlexParts in a ightning fast, client-based
application. No chent-side requirements. Warks on mast modern browsers

Figure 2 Switching to the Server Configuration Page

3. Navigate to Preconfigured Solutions | 3DPlay Experience for Work Instructions page.

© 7o access the DELMIA Apriso Server Configuration page from the server where
DELMIA Apriso is installed, you can also use the DELMIA Apriso 2021 Start link on
the desktop.

3.4 Deploying GPM Packages

To install the 3DPlay Experience for Work Instructions, use GPM to deploy the dedicated
package, which you can download from the 3.3 Install and Configure DELMIA 3DPlay
Experience for Work Instructions Page.

Components (GPM Packages)

The GPM Package files need to be deployed on DELMIA Apriso server for dedicated Database
Management System (SQL/Oracle) and in a specified sequence both indicated below {and in their file
names).

| 3DPlay Work Instructions 20 Cockpit

Figure 3 3DPlay Experience for Work Instructions GPM Package

2 2
2S DELMIA | Apriso DS SGSTENEsS



3D Work Instructions | DELMIA Apriso 2021 Implementation Guide 8

4 Configuration
4.1 Order Grid

The Order Grid Screen is the starting point for the Screens provided in the GPM package. This
Screen is used to select an Order in the system to view 3D work instructions. After an Order is
highlighted, the View Operations button is enabled in the upper right corner to view the 3D
work instruction.

The Screen contains a standard Apriso Grid Business Control. All existing columns can be
removed from the grid except for WipOrderNo and WipOrderType. Additional or alternate
columns can be added based on customer requirements. The Screen and component names
are as follows:

» WI3D_Orders (Screen)
> WI3D_OrderCockpit.List.With.Tabs (View)
» WI3D_OrderCockpit.List.With.Tabs (Operation)
> Grid (Business Control)

WI3D_Orders 1:45:31 PM_ System Administrator 2EHA

Profile: | Default Profiie | ~ | | & &

WIP Order No | WIP Order Type ¢ | WIP Order Description ¢ serialNo ¢ ProjectRank ¢ Priority | Rele... $ | ProductNo ¢ compiayy +| UOM | Date Start < | Date startea + | Due Date ¢ staws
B0 BO B0 =
BO BO B0

5012017 8:44:37 AM /1012017 8:44:37 AM New

101 Production Order c1P1 010

102 Production Order c1P1 o4 51012017 11:23:53 AM 51012017 11:23:53 AM New

201 Production Order c1P1 o5 5712017 2:08:43 PM 5/1712017 2:08:43 PM New

3 Production Order ctp1 020 5/0/2017 9:22:00 PM 5/0/2017 8:22:00 PM New

c1P1 o1 15 51812017 7:43:13 AM /1812017 7:43:13 AM Completed

401 Production Order fork Order 401 for the Jet Engine c1p1 05 EA 5(17/2017 9:08:43 PM 5/17/2017 0:08:43 PM New

501 Production Order L0 AT ATy 1Pl s 05 51252017 819:04 AM 5252017 8:19:04 AM New

Figure 4 Order Grid

To open an Order, double-click a row in the grid, or select that row and click View Operations.
The Screen Flow will navigate to a new Screen with the WipOrderNo and WipOrderType of
the Order.

4.2 Operations and Steps Screen

The Operations and Steps Screen allows the user to view and interact with 3D work
instructions. The Screen consists of three parts: the Operation and Step lists (tree control on
the left), the Work Instructions 3D Business Control (3D model in the center), and the Parts
and Tools lists (grids on the right). Selecting data on either side causes the 3DPlay content to
synchronize with the selected data. Data for synchronizing the various Views with the selected
Operations and Steps is passed to and from the Work Instructions 3D Business Control and
the Parts and Tools list control using JavaScript and JSON as the data format.

The Screen name is WI3D_Operations. The Screen can be used as-is or enhanced to meet
customer-specific requirements.

2 2
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Figure 5 Operations and Steps Screen
4.2.1 Operations and Steps List

The Operations and Steps list View uses a tree control that displays a list of the Operations
assigned to the selected Order and the Steps assigned to each Operation. The selected
Operation or Step is passed to the 3D Play Business Control via JavaScript and to the Parts
and Tools list Views, causing them to synchronize their data and display to the selected
Operation or Step.

The screen and component names are as follows:

» WI3D_Operations (Screen)
> WI3D_Operations_View (View)
» WI3D_Oper_List (Operation)
» Tree (Business Control)

The default configuration of the Operations and Steps list is:

» Multiple Selections for the tree control must be set to “False”. The Work Instructions 3D
Business Control will only accept a single Operation or Operation Step as an input.

» The RefName for an Operation is PROCESS OPERATION.PPROperationlID, and the
RefName for a Step is UNIT_CHARACTERISTIC.FreeTextValue. Operation and Step
identifiers are concatenated strings that include the “_” character. For both Operations and
Steps, only use the substring to the left of the “_". OprSequenceNo and StepSequenceNo
are needed for each row to filter Parts and Tools when selected. (StepSequenceNo will be
null if an Operation is selected.)

» The following events call JavaScript to synchronize the Views when an Operation is
selected:

2 2
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> NoOperationSelected — Resets the Work Instructions 3D Business Control, removing all
markup and returning to full product buildup. No JSON data is passed.

> OperationSelected — Passes the following data in JSON format to the Work Instructions
3D Business Control:

{'operId': "', 'refName': 'refl23', 'instName': ''}

The player will display a representation of the Operation specified by one of the
following input parameters: InstName (InstanceName), refName
(Reference.PLMExternallD), or operld (Reference.Title).

4.2.2 Work Instructions 3D Business Control

This View contains the Work Instructions 3D Business Control that displays 3D work
instructions authored in DELMIA. In order to locate the 3D data, the control requires the
WipOrderNo and WipOrderType of the selected Order to be passed at initialization time.

1 work_Instructions_30

I
. t;r WipiorderTo
' 0 [} WipOrder Type
. t}r Opraequencebo
' 0 [}\ DocurnentID

Figure 6 Work Instructions 3D Business Control

The screen and component names are as follows:

» WI3D_Operations (Screen)
> WI3D_3D_View (View)
» WI3D_3D_Operation (Operation)
» Work_Instructions_3D (Business Control)

JavaScript is used to manipulate the 3D work instructions loaded in the Business Control. The
JavaScript passes data in JSON format. Various APIs exist to select the Views associated
with a selected Operation or Step and highlight Parts and Tools. For more information on this
Business Control, see the Business Controls section of the Process Builder Help.

4.2.3 Parts and Tools List

This View contains Grids that list the Parts and Tools for the selected Operation or Step.
Selecting a Part or Tool will cause the component to be highlighted in the 3D model displayed
by the Work Instructions 3D Business Control.

The screen and component names are as follows:

2 2
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>

WI3D_Operations (Screen)
> WI3D_Details_View (View)
» WI3D_Part_List (Operation)
» GridToolList (Grid Business Control)
» GridPartList (Grid Business Control)

The default configuration of the grids is as follows:

>
>

>

The CSS class names for the Parts and Tools Grids must be different from each other.
The WipOrderType and WipOrderNo must be passed to both Grids so they can select the
proper data from the database.
The Selection Mode for the Grids should be “Single”.
The Parts Grid must include the PRODUCT .ProductNo for each Partin the Grid. (This does
not have to be visible on the Grid.)
The Tools Grid must include the EQUIPMENT .Equipment for each Tool in the Grid. (This
does not have to be visible on the Grid.)
Additional columns from the Part and Tool objects can be added to the Grids, but you may
need to adjust the screen layout since space is limited. (A scroll bar will be displayed if the
Grid is too wide.)
A JavaScript event listener is included for messages. This is needed to interact with the
Work Instructions 3D Business Control for any Parts that are selected on the model.
> If the messageType is “3DPlayEvent3DPartSelected”:
> Ifthe Action is “add”, toggle the selection for the Grid item that corresponds to the
selected Part to “true”.
> Ifthe Action is “remove”, toggle the selection for the Grid item that corresponds to the
selected Part to “false”.
> If the messageType is “3DPlayEvent3DSelectModeChange”:
» Ifthe mode is “single”, change the Parts and Tools Grids to “Single” Selection Mode.
» If the mode is “multiple”, change the Parts and Tools Grids to “Multiple” Selection
Mode.

The AprisoPartSelected event is called when an item on the Parts Grid is selected and
passes this JSON data to the event:

{'CompInstanceID': "', 'PLMEntityName': '', 'ProductNoOrEquipment': 'Part123'}

The player will select a Part in the model specified by one of the following input
parameters: ComplnstancelD (InstanceName), PLMEntityName
(Reference.PLMExternallD), or ProductNoOrEquipment (Reference.Title).

The AprisoToolSelected event is called when an item on the Tools Grid is selected and
passes this JSON data to the event:

{'CompInstanceID': '', 'PLMEntityName': '', 'ProductNoOrEquipment’': 'Tooll23'}

2 2
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The player will select a Tool in the model specified by one of the following input
parameters: ComplinstancelD (InstanceName), PLMEntityName
(Reference.PLMExternallD), or ProductNoOrEquipment (Reference.Title).

» The emptySelected event is called to clear out all of the selected Parts and Tools for the
Work Instructions 3D Business Control when a different Part or Tool is selected on the Grid.

4.3 Supported 3DExperience Data

Part references/instances must be unique in order to support the cross-highlighting of
individual Parts. If the names are not unique, a single Part using the non-unique name will be
assigned to the Operation or Step level with the Quantity updated to reflect the total number of
Parts using the non-unique name. When a Part with a non-unique name is selected in the
Parts list, all Part references using the non-unique name will be highlighted in the 3D model.

2 | 2
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5 Known Issues

In some scenarios 3DPlay Experience for Work Instructions performance may
be sub-optimal

Symptoms:

The system may stop responding when displaying a complex 3D model using DELMIA
3DPlay Experience for Work Instructions.

Problem Description:

In the case of less powerful hardware configurations, the 3D model display performance may
be sub-optimal due to significant use of system resources.

It is not possible to annotate 3D model when using iOS app
Symptoms:

When using 3DPlay Experience for Work Instructions in iOS, it is not possible to annotate the
opened 3D model using the Tools > Annotation Commands > Text option.

Problem Description:
This is a known issue with the 3DPlay control, which will be addressed in a future release.

The server returns a 404 error for certain files when the 3D Work Instructions
control loads

Symptoms:

When the 3DWI control loads, the server returns a 404 error for the following files:

» /Apriso/Portal/3DPlay/3DPlay/.3DPlay.mkversion.mk (Firefox, Chrome, Microsoft Edge, and

Microsoft Edge Legacy)

» /Apriso/Portal/3DPlay/DMU*/DMU*.js

» /Apriso/Portal/3DPlay/QualityManager/QualityManager.js (Chrome Version 65.0.3325.146
[Official Build] [64-bit])

Problem Description:

These errors do not impact functionality.

Multiple selection missing for 3D Work Instructions in iOS and Android
Symptoms:

When using 3DPlay Experience for Work Instructions in iOS or Android, the multiple selection
button is missing.

2 2
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Problem Description:

There is not enough space to display the multiple selection button, so the button is
automatically hidden.

Error messages for Connected Mode are not displayed in the Ul

Symptoms:

When using 3DPlay Experience for Work Instructions in Connected Mode, there are no error
messages displayed in the Ul when a 3D model does not load.

Problem Description:

In Connected Mode, error messages are sent only to the console, and are not displayed to the
user.

Connected Mode 3D Model is not displayed in DELMIA Apriso Mobile
Application on i0S

Symptoms:

When using 3DPlay Experience for Work Instructions in Connected Mode, the 3D model is not
displayed in the DELMIA Apriso Mobile Application on iOS.

Problem Description:
This is a known issue with the 3DPlay control, which will be addressed in a future release.
Workaround

Open the 3DPlay Experience for Work Instructions in DELMIA Apriso Portal.

2 2
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6 References

Internal Documentation

1. Process Builder Help

Provides an overview of DELMIA Apriso Process Builder (PB) and information on installing
and using the application. This Help describes the user interface elements, entity
maintenance, available Business Controls, and management of Processes, Operations,
and Screen Flows.

2. DELMIA Plan Approval and Distribution Integration Implementation Guide

Describes what configurations have to be created, changed, or validated in DELMIA Apriso
before the whole solution can be used for manufacturing.

3. Security Implementation Guide

Provides an overview of DELMIA Apriso security and information on effectively securing all
instances of DELMIA Apriso.

3DS Support Knowledge Base

If you have any additional questions or doubts not addressed in our documentation, feel free to
visit the 3DS Support Knowledge Base at hitps://support.3ds.com/knowledge-base/.

All the internal documents referenced in this section are available from the DELMIA Apriso m
Start page, which can be accessed on your DELMIA Apriso server (<server name>/apriso/start). 2 )
The newest versions of all documents are available from 3DS Support at: o '

https://www.3ds.com/support/documentation/ T

3D
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